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Bulk Updates
Bulk update is an efficient way of updatingmultiple objects in a single operation, and it is available on themajority
of objects in Tree or SystemSetup that have an editor. A user can also run the bulk update process on a collection,
on a search result, or multiple selected objects.

The Bulk Update wizard guides a user through the process, and ensures all necessary settings and data is
provided to run the update.

Setup Requirements
Setting up and using a bulk update involves the following steps:

1. Determine themethod required to start the Bulk Update wizard as described inCreating a Bulk Update.
2. In the wizard, choose a previously saved configuration or create a new one as described inBulk Update

Configuration.
3. In the wizard, choose one or more operations that will run during the update as described inBulk Update

Operations.
4. In the wizard, supply the required parameters as described inBulk Update Parameters.
5. In the wizard, review the expected results of the update as described inBulk Update Preview.
6. In the wizard, set the required options and run the bulk update as described inBulk Update Advanced.

Additional Information
The following information is useful once a bulk update is created or run:

1. Monitor a bulk update through a background process as described inMonitoring Bulk Updates.
2. Schedule a bulk update as described inScheduling Bulk Updates for Collections.
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Creating a Bulk Update
The bulk update functionality allows a user to easily update a large number of objects in a single operation.

To perform a bulk update:

1. Determine the data that should be updated.

2. Use one of the followingmethods to select data to be updated and launch the Bulk Update wizard.

l Run on all objects in a single collection or multiple collections: In Tree, select one or more
collections, right-click and chooseRun Bulk Update.

l Run on a single or multiple selected objects in Tree or System Setup: Select one or more of the
objects defined in the following table, then from themenu choose File > Bulk Update > Run Bulk Update.

Note: To run a saved bulk update configuration (which loads the operations and settings) first start the wizard,
and then choose the existing configuration on the Configuration step shown below.

Tree Objects System Setup Objects

l Assets

l Classifications

l Collections

l Configurations

l eCatalogs

l Entities

l IndexWords

l Products

l Publication groups

l Publication object
sections

l Attributes

l Attribute Transformations

l Asset Importer

l Change Packages

l CompletenessMetrics

l Event Processors

l Event Queues

l GatewayEndpoints

l GDSN- Data pool- Receiver or
publisher

l Global BusinessRules

l List of Values

l Match Codes andMatching Algorithms

l Outbound Integration Endpoints

l Tables

l Tags

l Units

l Users andGroups

l WebUIs

l Workflows

l Workflow Profiles

l Reference types / link types
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Tree Objects System Setup Objects

l DTP documents in the
publication hierarchy

(actions, conditions, and
libraries)

l Inbound Integration Endpoints

l Keys

l Object type & structures (asset,
classification, publication, setup group,
etc.)

l Context -Dimension points

l Run on search results: Perform a search, and click theBulk Update button ( ).

For more on the Search tab in workbench, see theSearch topic in theGetting Started / User Guide
documentation.
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3. The Bulk Update wizard displays and can involve the following steps:

l Configuration allows you to choose a previously saved configuration or create a new one.

l Operations allows you to choose one or more operations that will run during the update.
l Parameters allows you to supply any required parameters.
l Preview allows you to review the expected results of the update.

l Advanced allows you to set the required options and start the background process that runs the bulk
update.
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Bulk Update Configuration
Specify the configuration that should be run for the bulk update.

1. Choose the option for the desired configuration:

l Click the 'Use Existing Configuration' radio button to use a saved bulk update configuration, then click the
ellipsis button ( ) to display the configuration selection dialog. Select the relevant configuration and click the

Select button.

l Click the 'Create New Configuration' radio button to create a new configuration.

2. Click theNext button to display theBulk Update Operations.
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Bulk Update Operations
Specify the operations the bulk update should perform on the selected objects. When an existing configuration is
selected, all saved operations are displayed.

1. Add or edit the required operations as follows:

l For a new configuration, the default 'Merge Attribute Values' operation is displayed. Select the desired
operation from the dropdown as defined in the individual topics that follow this topic.

l Click the 'AddOperation' link to configure an additional operation.

l Click the delete button ( ) to remove an operation.

l Click the up and down arrow buttons ( ) to change the order of the operations applied to the update.

Important: Ensure that the operations are listed in the order that they need to be performed—from the top
down. Thismeans that whenmultiple operations are included, those run first can be overwritten by operations
that run later. If one operation fails for an object (for example, due to validation base typemismatch), all
changes to the object will be rolled back and the object will be left as if was prior to applying the Bulk Update.

2. Click theNext button to display theBulk Update Parameters.
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Attribute Values: Merge Attribute Values Operation
Copies the values from the first selected attribute to another selected attribute, in the current workspace, based on
the parameter settings. For dimension dependent attributes, the copy is performed across all dimensions or
applicable combinations of dimensions.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Verify Attributes for Merge
This operation can also be started fromSystemSetup by selecting an attribute, then right-click and select Merge
Attribute Values. For details about verifying the attributes before performing this operation, see theMerging
Attribute Values section of theSystem Setup / Super User Guide.

Tomerge attribute values for only some objects, go to theSearch tab, and create Search Results of the objects to
merge. Then either click theCollections button to save the results as a collection (which can be used for repeated
updates), or click theBulk Update button and clickNext to display the Operations page and the followingMerge
Attribute Values parameters.

Configuration
1. SelectMerge Attribute Values from the dropdown.

2. In the 'Merge' parameter, click the ellipsis button ( ) to display the Select Attribute dialog, choose the attribute

to copy values from, and click theSelect button.
3. In the 'into' parameter, click the ellipsis button ( ) to display the Select Attribute dialog, choose the attribute to

copy values to, and click theSelect button.

4. For the 'SourceWorkspace' parameter, use the dropdown to select the workspace that holds the values to be
copied to the target, based on the other parameters. Values are always pasted into theMain workspace.

Consider the following example data, and assumewewill choose to Overwrite existing values (as described
below). Selecting the SourceWorkspace = Main will result in writing the T-shirt Size value of S, while selecting
SourceWorkspace = Approved will write the XS value.
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5. For the 'Overwrite' parameter, choose an option to determine when to write to the target attribute. Validation
errors are displayed on the Preview page when a value cannot bemodified.

Consider the following data and the effects of the options as shown in the Preview images below. 'T-shirt Size'
is the source attribute and 'Size' is the target attribute:

l Keep original valuesmeans the source value is only copied to the target attribute when the target attribute
is blank. If the target attribute contains a value, the target value is not changed. Notice that the only value
changed in this scenario is for object 18212 L B, since the source object had a value and the target value was
blank. Since the other objects either had values for the target or the source was blank, none of themwere
modified.
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l Overwrite existing valuesmeans the source value overwrites the target value, except when the source
attribute is blank. If the source attribute is blank, the target value is not changed. Notice that two values
changed in this scenario: object 18210MB had its value overwritten since a value existed for the source, and
object 18212 L B was overwritten since the source object had a value and the target value was blank.
Objects 18213MOand 18216 LOboth had blank source values, so the target valueswere not overwritten.

6. For 'Merge Link Attributes' parameter, if the selected attributes are both used as an attribute on a reference, a
product classification link, or an attribute link, merging of those values are based on the Yes or No set in this
parameter, as well as the other parameters on the operation. This option is not relevant when values do not
exist on references for the selected attributes.

For example, consider the following values for the attributes 'Qty of Next Lower Package' and 'Qty of Next
Higher Package' on the Case to Child reference.

Setting the operation parameters as 'Qty of Next Lower Package' for the source, 'Qty of Next Higher Package'
for the target, using theOverwrite existing values, and settingMerge Link Attribute = Yes results in this preview
of resulting values:
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For more information about attributes on references, see theProduct Attribute Link Type section of the
System Setup / Super User Guide documentation.

Note: TheMerge Attribute Values operation does not delete any attributes, it can only update values. If desired,
manually delete the source attribute once you confirm themerged data.
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Attribute Values: Set Value Operation
Sets the value of the selected attribute based on a value enteredmanually or via a function.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectSet Value from the dropdown.

2. For the first parameter, click themanual ('abc') button or the function ('fx') button and then click the ellipsis
button ( ).

Note: The selected attribute dictates the label on themanual button. In the image below, the selected attribute
requires a text value and so the label is 'abc.' If the selected attribute is numeric, '123' is displayed, and so on
for each validation base type.

l For manual selection, the Select Attribute dialog is displayed, select an attribute, and clickSelect.

l For function selection, click the ellipsis button ( ) displayed near the text field to display the Function Editor

dialog. Add a function and evaluate, the clickOK. See theUsing Function Editor topic within the
Resource Materials online help for more information on writing functions.

3. For the second parameter (=), click themanual ('abc') button or the function ('fx') button.

l For manual selection, type the value required for the selected attribute into the text field.

l For function selection, click the ellipsis button ( ) displayed near the text field to display the Function Editor

dialog. Add a function and evaluate, the clickOK. See theUsing Function Editor topic within the
Resource Materials online help for more information on writing functions.
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Data Containers: Update Data Containers
Operation
The following option is available for Data Containers. For more information on Data Containers, see theData
Containers topic in theSystem Setup / Super User Guide documentation.

This operation allows users to run business actions on selected data container objects. When executing this
operation, users can filter which data container objects to work with by specifying a business condition and/or data
container type, before running the specified business action on those objects.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectUpdate Data Containers from the dropdown.

2. In the 'Data Container Type' parameter, (optional) click the ellipsis button ( ), select the data container type

this operation should apply to, and clickSelect.
3. In the 'BusinessCondition' parameter, (optional) click the ellipsis button ( ), select the data container type this

operation should apply to, and clickSelect.
4. In the 'Business Action' parameter, (required) click the ellipsis button ( ), select the data container type this

operation should apply to, and clickSelect.
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Data Quality: Generate Match Codes Operation
Use this operation to generatematch code values for the selected objects of the bulk update.

For more onmatch codes and how to create them see theConfiguring Match Codes topic in theMatching and
Linking documentation.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. Select objects for the bulk updated and open the Bulk Update wizard.

2. SelectGenerate Match Codes from the dropdown.

3. For the 'Match code' parameter, Click the ellipsis button ( ), select thematch code to use, and clickSelect.

Note: Collection objects shouldmatch to thematch code object type and category.
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Data Quality: Match Duplicates Operation
DEPRECATED. Instead, use 'Send Republish Event' to Event Processor configured to applymatching using
user'smatching algorithm, as defined in theSend Republish Event Operation topic.

This option applies the selectedmatching algorithm on selected objects for the bulk update. This includes
generating a list of possible duplicates and a score that indicates how identical the objects are. And if a golden
recordmatching algorithm is used it will also update golden record links and re-apply survivorship rules.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectMatch Duplicates (apply matching algorithm) from the dropdown.

2. For the 'Matching Algorithm' parameter, click the ellipsis button ( ), select the algorithm to use, and click

Select.
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Data Quality: Standardize Address Operation
This operation allows for different standardization actions to be taken on addresses by using the Loqate solution. If
applicable, CASS (Coding Accuracy Support System) operations can also be performed to apply a stricter level of
address validation to US-based addresses.

Standardize Address bulk update operations are valid for execution on entities with flat attributes, e.g. Address
object types and addressData Containers (Data Containers with address attributes).

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Prerequisites
Before a Standardize Address bulk update operation can be run, the following conditionsmust bemet:

l Usersmust be connected to a Loqate server, either through a cloud API or local API.

l The AddressComponent Model must already be configured. It is strongly recommended to configure this
component model using the 'Easy setup of AddressComponent Model' wizard. For more information, see the
Address Component Model section of the Loqate documentation.

l To view and use the CASS features, usersmust:

l Purchase a CASS license

l Be connected to Loqate through a localAPI (CASS components will not work with a Loqate Cloud
API)

l Be based in the US, asCASS is not valid outside of the US

l Configure the CASS AddressComponent Model. For more information, see theCASS Address
Component Model topic in the Loqate documentation.

Configuration
This documentation topic describes the options available when configuring a Standardize Address bulk update
operation. For more detailed information on the overall Loqate and CASS solutions, see the Loqate Integration
section of theData Integration documentation.

1. SelectStandardize Address from the dropdown.
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2. Make selections for the parameters as defined in the following sections.

Address Standardization Modes Parameter
Three options are available from the Address StandardizationMode dropdown list.

l Overwrite Existing Standardized Address:Overwrites an existing standardized address bymaking a call to
Loqate, which returns the latest standardized address and overwrites the existing one.

l Generate Hash Value Only:When this option is chosen, the business action will recalculate the 'Validation
Hash' value without making a call to Loqate. The hash value is based on the address input fields only and is
calculated andmaintained by STEP.

This option is used in caseswhen pre-standardized addresses, which are known to be correct, are imported.
Because the addresses are new, no hash value is present. When the 'Generate Hash Value only' action is run,
STEP generates a hash value and places it into the 'Validation Hash' field. The hash value lets STEP know that
the addresses are new, ensuring that they are not picked up and restandardized by STEP shortly after they are
imported. For users of the Loqate Cloud API solution, this savesmoney by avoiding unnecessary calls to
Loqate, since users are charged a fee for every call made to Loqate.

l Disable Address Standardization: This option is primarily useful for users who import addresses in bulk,
either manually or by using an inbound integration. If a business rule is in place that runs a Standardize Address
bulk update on import, then selecting 'Disable Address Standardization' is a simple way to temporarily turn off
automatic address validation on import. This allows users to validate the addresses later.
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Renew Address Validations Parameter
The checkbox optionRenew address validations older than allows for addresses older than a designated
number of days to be revalidated. This is useful in case an addresswas validated an extended period of time ago
and the addressmay no longer be valid. The default number of days is 160. The field is disabled by entering the
value '0.'

STEP determines the age of an address by the value present in the 'Validation Time' field.

Important: For users of the Loqate Cloud installation, care should be exercised when using this functionality.
Since all addresses older than the specified time period will be revalidated, each additional validation will make a
chargeable call to Loqate.

CASS Validation Parameters
TwoCASS address validation options are available on the Standardize Address dialog.
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l Turn on CASS validation for US addresses: If checked, all addresses are sent for standardization to the
Loqate Local server integration and also validated against CASS data.

l CASS Certification Report Event Processor: If you would also like a CASS certification report generated
after using CASS validation on an address, click the ellipsis button ( ) and select the relevant CASS

certification report event processor from the 'Select Event Processor' dialog. For more information, see the
CASS Certification Report Processing Plugin Parameters and Triggers section of theEvent
Processors documentation.
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Publishing: Check Publication Document for
Needs Update Operation
A page will need an update if any elementsmounted on the page (for example, attribute values or image
references) have changed in STEP since the page was originally saved to STEP.

This operation checks all actual pages saved to the selected publication / section to determine if updates are
needed.

Checking documents for updates fromwithin the STEPWorkbench is primarily useful for AutoPage and
Flatplanner publications. Since near-identical functionality can be accessed from other locations in the workbench
(including right-clicking on a publication or section object in the Tree and clicking 'Check for update needed...'), the
use cases and applications for checking documents for updates are detailed in the following publishing-specific
topics instead:

l Updating Documents in AutoPage in theAutoPage documentation
l Updating Documents in Flatplanner in the Flatplanner documentation

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectCheck Publication Document for Needs Update from the dropdown.

2. No parameter configuration is required.
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Publishing: Remove Flatplans from STEP
Workflow Operation
This operation is legacy functionality (pre-STEP 8.0) fromwhen only one workflow at a time was allowed for
planned pages. There is no ability to select a specified workflow.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectRemove Flatplans from STEP Workflow from the dropdown.

2. Type a 'ProcessNote' to name the background process used.

Note: If only using one Flatplanner workflow, this removes all planned pages from the workflow.
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Publishing: Start Flatplans in STEP Workflow
Operation
Adds all Flatplanner spreads (planned pages) in the selected publication group, publication, or section into the
specified Flatplanner workflow. The bulk update is initiated by right-clicking on the desired publication group,
publication, or section. A selection of planned pages can also be chosen for bulk initiation into a Flatplanner
workflow bymulti-selecting them and going to File > Bulk Update > Run Bulk Update.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectStart Flatplans in STEP Workflow from the dropdown.

2. In the 'Workflow' parameter, select the desired workflow from the dropdown.

Note: Only workflows valid for planned pages are displayed. Flatplans that are already in a workflow are not
affected.

3. In the 'ProcessNote' parameter, type a name for the background process.
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Publishing: Update Publication Document
Operation
The 'Update publication document' bulk update option functions almost identically to theUpdate feature that is
directly accessed by right-clicking on publication, section, or DTP document objects in the Tree. The selections in
the 'Operations' dialog pictured above are identical to those in the 'Update contents of documents' dialog that is
accessed through the 'Update' feature. Because of these similarities—and because the 'Update' feature ismore
commonly used than the bulk update feature to update documents—this feature is detailed in the STEP'n'design
documentation instead. SeeUpdating Documents From the Workbench in theSTEP'n'design
documentation for more information.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectUpdate Publication Document from the dropdown.

2. Choose one of these options:

l Update all contents of section: This updates all information on all actual pages saved to the selected
publication, section, or DTP document.

l Update only the following items of the selection: Choosing this allows for the selection of specific items
to be updated on the actual pages, such as attributes, image references, and table types.
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References and Links: Add Attribute Link
Operation
The selected attribute will be linked to the collection of valid objects.

l If the attribute is on an object, it can be viewed on the References tab on the object, under the 'Linked Attributes
fromProduct Hierarchy' flipper.

l If the attribute does not have an editable field (or link) to store data, this option adds a link and allows data to be
stored.

For more information on linked attributes see theAttribute Links topic in theSystem Setup / Super User
Guide documentation.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectAdd Attribute Link from the dropdown.

2. In the 'Attribute' parameter, click the ellipsis button ( ), select the attribute that will be updated, and click

Select.

Example
The following images show before and after the 'BatteryType' Add Attribute Link bulk update is run.

© Stibo Systems - Confidential - STEP Trailblazer 9.0MP5November 2018 27



© Stibo Systems - Confidential - STEP Trailblazer 9.0MP5November 2018 28



References and Links: Automatic Classification
Operation
Classifies the selected objects automatically according to a set of rules.

The Automatic Classification functionality is controlled by a component model. For more information, see the
Automatic Classification documentation.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Prerequisites
TheRule Set object instance in Treemust be configured per the component model definition.

Configuration
1. SelectAutomatic Classification from the dropdown.

2. For the 'Rule Set' parameter, click the ellipsis button ( ), select the rule set, and clickSelect.

3. For the 'Use approved rule set' parameter, when checked, only approved rule sets can be used for this
operation.

4. For the 'Evaluation Context' parameter, from the dropdown, select the context in which the rule conditions
should be evaluated.
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References and Links: Industry Classification
Synchronization Operation
This operation allows users to reclassify products to newer eCl@ss, ETIM, or UNSPSC versions.When
executing this operation the specified product to classification link type will be overwritten with the new version of
the classification hierarchy for all updated products.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. Run a search for any products that need their classification links updated to a newer eCl@ss, ETIM, or

UNSPSC classification hierarchy, and run the bulk update wizard.

2. Select Industry Classification Synchronization from the dropdown.

3. In the 'Industry standardmatcher' parameter, select the relevant industry standard from the dropdown list.

4. In the 'Source classification root' parameter, click the ellipsis button ( ), select the classification root node for

the original industry classification version, and clickSelect.
5. In the 'Target classification root' parameter, click the ellipsis button ( ), select the classification root node for

the new industry classification version, and clickSelect.
6. In the 'Product to classification link type' parameter, click the ellipsis button ( ), select the product to

classification link type the products use to link into the classification hierarchy, and clickSelect.
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References and Links: Link Asset to Classification
Operation
This allows users to link assets to a specified classification.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. Select the assets that need to be linked, and run the bulk update wizard.

2. Select Link Asset to Classification from the dropdown.

3. In the 'Classification' parameter, click themanual ('abc') button or the function ('fx') button and then click the
ellipsis button ( ).

l For manual selection, the Select Classification dialog is displayed, select a classification object, and click
Select.

l For function selection, the Function Editor dialog is displayed. Add a function and evaluate, the clickOK. See
theUsing Function Editor topic within theResource Materials online help for more information on
writing functions.

Once the bulk update runs, assets appear under designated classification folder.
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References and Links: Add Reference or Add
Referenced By Operations
Add Reference andAdd Referenced By both have similar configurations for bulk updates. Performing this
action forAdd Reference adds a reference of a specified type to a target. Alternatively, forAdd Referenced By
this adds a reference from a target to the source.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. Select the objects that are to receive the reference and run the bulk update wizard.

2. SelectAdd Reference or Add Referenced By from the dropdown.

3. For the 'Type' parameter, click the ellipsis button ( ), select the reference type, and clickSelect.

4. For the 'Target' or 'Source' parameter, click themanual ('abc') button or the function ('fx') button and then click
the ellipsis button ( ).

l For manual selection, the Select Reference Target or Select Reference Source dialog is displayed, select a
Target or Source object that is in accordance with the selected link type, and clickSelect.

l For function selection, the Function Editor dialog is displayed. Add a function and evaluate, the clickOK. See
theUsing Function Editor topic within theResource Materials online help for more information on
writing functions.

Note: The selected object dictates the label on themanual button. In the image below, the selected objects
requires a text value and so the label is 'abc.' If the selected object is numeric, '123' is displayed, and so on for
each validation base type.

Examples
An example usingAdd Reference is below:
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Similarly, a user could specify a function in the function editor by selecting the 'fx' button and clicking the ellipsis
buttons to bring up the editor.

Again, an example usingAdd Reference is below though it works the sameway forAdd Referenced By:

After selecting the 'Type' of reference, a user opens the function editor and types in the function needed. In this
case there is an attribute on the item called 'Product Image' that holds the ID of an image asset.

When the bulk update is run, it uses the ID in the attribute to call forth which asset to put on the Primary Product
Image reference.
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References and Links: Remove Attribute Link
Operation
This option removes the selected link to an attribute when the selected object is linked to the attribute.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectRemove Attribute Link from the dropdown.

2. For the 'Attribute' parameter, click the ellipsis button ( ), select the attribute that will be updated, and click

Select.

Example
The following images show before and after the 'BatteryType' Remove Attribute Link bulk update is run.
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References and Links: Remove Reference
Operation
This option removes references to a specific target or all references of a specific type.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectRemove Reference from the dropdown.

2. For the 'Type' parameter, click the ellipsis button ( ), select the reference type, and clickSelect.

3. For the 'Target' parameter, determine which object type(s) are affected as follows:

l To remove references from a specific target, for the Target parameter, click themanual ('abc') button or the
function ('fx') button and then click the ellipsis button ( ).

l For manual selection, the Select Reference Target dialog is displayed, select a Target object that is in
accordance with the selected link type, and clickSelect.

l For function selection, the Function Editor dialog is displayed. Add a function and evaluate, the click
OK. See theUsing Function Editor topic within theResource Materials online help for more
information on writing functions.

l To remove all references of a specific type from all targets, leave the Target parameter blank and check the
'Remove all targets' checkbox.
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Example
The 'Product Image' attribute on the item holds the ID of an image asset.

When the bulk update runs, it uses function to determine the value of the attribute, to find which reference to
remove from the Product Image type.
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References and Links: Set Product to
Classification Link Type Operation
This assigns a new object type and a classification link type to the selected classifications.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Prerequisites
Verify the object type is valid for the classification type.

Configuration
1. SelectSet Product to Classification Link Type from the dropdown.

2. For the 'New Object Type' parameter, click the ellipsis button ( ), select the object type, and clickSelect.

3. For the 'New Link Type' parameter, click the ellipsis button ( ), select the link type, and clickSelect.

Example
In the following example data, Website1 object type is valid for the 'WebHierarchyRoot', but will be changed to be
valid for 'MerchandisingHierarchyRoot.'
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The items under theWebHierarchyRoot with theWebsite Link are now going to be of the object type
'Merchandising HierarchyRoot' with theMerchandisingLink type.
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References and Links: Unlink Asset from
Classification Operation
Using this operation, selected assets are unlinked from the specified classification.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectUnlink Asset from Classification from the dropdown.

2. For the 'Classification' parameter, click themanual ('abc') button or the function ('fx') button and then click the
ellipsis button ( ).

l For manual selection, the Select Classification dialog is displayed, select a classification object where the
assets will be unlinked, and clickSelect.

l For function selection, the Function Editor dialog is displayed. Add a function and evaluate, the clickOK. See
theUsing Function Editor topic within theResource Materials online help for more information on
writing functions.

Examples
Using the setting displayed in the image above, the operation is run on the data shown below. The preview shows
that the IllustrationRoot classification reference will be removed.
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Another example uses the following product and a function to determine the link being removed. The 'Asset
Keywords' attribute on the 'BlueTruckIcon' item holds the ID of the classifications folder. In this case, the reference
to 'BlueTruckIcon' should be removed from the Illustrations classification folder.

TheProdval("Asset Keywords") function is used to remove the classification link by getting the value of the
attribute that holds the ID of the link to be removed.
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Once completed, the asset is no loner linked to the Illustrations classification folder.
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Run Business Rule Operation
This operation runs a business condition and/or action on the selected objects.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectRun Business Rule from the dropdown.

2. For the 'BusinessRule Condition' parameter, if a condition should be run, click the ellipsis button ( ), select

the condition, and clickSelect. If the condition evaluates to 'true', the selected business action will run.
3. For the 'BusinessRule Action' parameter, click the ellipsis button ( ), select the action, and clickSelect. If the

action should always run, no condition should be selected.
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Send Republish Event Operation
This option performs the same operation as selecting 'Republish' on a receiving processor. A republish event is
sent to the event queue of the selected processor for all objects selected for the bulk update.

For more on republishing, see theEvent-Based OIEP Forward, Rewind, Purge, and Republish topic in the
Outbound Integration Endpoints section of theData Exchange documentation.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectSend Republish Event from the dropdown.

2. For the 'Receiving Processor' parameter, click the ellipsis button ( ), select the receiving processor, and click

Select.

This can be an event processor, outbound integration endpoint with an event queue, or an event queue
directly.

Example
For example, in the images below, the 'ItemAttribute Change' OIEP is selected as the receiving processor. It has
no events ready to process. Running this bulk update operation adds an event to the OIEP.
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Set Name Operation
This operation sets the name of the object on which the bulk update is run. A user can either enter the name
manually, or specify a function in the Function editor for naming the object.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectSet Name from the dropdown.

2. For the 'Name' parameter, click themanual ('abc') button or the function ('fx') button.

l For manual selection, type the name into the text field.

l For function selection, click the ellipsis button ( ) displayed near the text field to display the Function Editor

dialog. Add a function and evaluate, the clickOK. See theUsing Function Editor topic within the
Resource Materials online help for more information on writing functions.

Example
To create a name using the function editor, often attribute values on an item are concatenated. In the image below,
the 'Primary Color' and 'Brand Name' attributeswill be combined to create the name of this flashlight.
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Using the Concatenate function, the value from two attributesmake a name for this flashlight item.
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Set Object Type Operation
This operation changes the object type of the object on which the bulk update is run. The selected object type
should be valid under the parent of the current object.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectSet Object Type from the dropdown.

2. For the 'Object Type' parameter, click the ellipsis button ( ) for manual selection or click the function ('fx')

button.

l For manual selection, select an object type from the dropdown.

l For function selection, click the ellipsis button ( ) displayed near the text field to display the Function Editor

dialog. Add a function and evaluate, the clickOK. See theUsing Function Editor topic within the
Resource Materials online help for more information on writing functions.

Example
The example below, 'Attribute C' on the item holds the ID of an object type.
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When the bulk update runs, it uses the value in the attribute to determine the object type.
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Workflow: Claim Operation
Workflow tasks are assigned to user groupswhere individual users in those groups can then claim the task for
themselves. A user can use the Claim operation to claim a number of tasks at once based on workflow and state.

For more information on claiming bulk updates in workflows see theBulk Update Operations for Workflows
topic in theWorkflows documentation.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectClaim from the dropdown.

2. For the 'STEPWorkflow' parameter, select the workflow from the dropdown.

3. For the 'Current State' parameter, select the state from the dropdown.

When the bulk update runs, all tasks in the selected workflow with the selected state are claimed for the user.
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Workflow: Initiate Items in STEP Workflow
Operation
This operation initiates the bulk update objects into the selected workflow, assuming that the objects selected are
valid for the workflow.

For more information on initiating items in a STEP workflow via bulk updates see theBulk Update Operations
for Workflows topic in theWorkflows documentation.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. Select Initiate Items in STEP Workflow from the dropdown.

2. For the 'Choose aWorkflow' parameter, select the workflow from the dropdown.

3. For the' ProcessNote' parameter, type a note for the background process.
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Workflow: Remove Items from STEP Workflow
Operation
This operation removes all objects from one state in a workflow.

For more on how to remove items fromSTEPWorkflows using bulk updates, see theRemove Objects From
Workflows topic in theWorkflows documentation.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. SelectRemove Items from STEP Workflow from the dropdown.

2. For the 'Choose aWorkflow' parameter, select the workflow from the dropdown.

3. For the 'ProcessNote' parameter, type a note for the background process.
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Workflow: Trigger STEP Workflow Event Operation
This operation allows a user to move a task from one state to another state.

For more on triggering STEPWorkflow events, theBulk Update Operations for Workflows topic in the
Workflows documentation.

For more information on the Bulk Update wizard, see theCreating a Bulk Update topic.

Configuration
1. Select Trigger STEP Workflow Event from the dropdown.

2. For the 'STEPWorkflow' parameter, select the workflow from the dropdown.

3. For the 'Current State' parameter, select the state from the dropdown.

4. For the 'Event' parameter, select the workflow event from the dropdown.

5. For the 'ProcessNote' parameter, type a note for the background process.
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Bulk Update Parameters
The parameters step is only enabled when the 'Run BusinessRule' operation is selected on theOperations step,
and the selected JavaScript business rule includes one or more 'Attribute Validated Parameter' binds.

For more information, see theParameterized Business Actions in Web UI topic in theWeb User Interfaces /
Web UI Setup and User Guide documentation.

1. If the Parameters step is enabled, supply the necessary data.

2. Click theNext button to display theBulk Update Preview.
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Bulk Update Preview
This step of the wizard shows some of the results of the configured operations. A maximumof 10 objects are
displayed. For each object, the existing data is shown on the 'Old' row and the data that will result from the update
is shown on the 'New' row.

1. Hover over a warning or error icon to review potential problemswith the bulk update

2. Click theBack button to resolve warnings and errors bymodifying an operation or parameter.
3. Click theNext button to displayBulk Update Advanced.
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Bulk Update Advanced
In the final step, select one or more of the available options.

1. Set the following parameters as necessary:

l Do not run now runs the bulk update later, and not immediately when the wizard is finished. This allows a
user to save the configuration.When check, theAuto Approve andPre-flight parameters are disabled.

l Auto Approve approves the updated objects once the update succeeds. The objects are displayed in the
approved workspace.

l Pre-flight performs a test run of the update. When the user clicks 'Finish', the test runs in a background
process. Selected operations are applied and then rolled back. An execution report and an impact report is
generated. Temporary collections are created for the objects where the operationswere successfully
applied, and for the oneswere errors were generated. The availability of this option depends on the user's
system setup.

Important: There is no 'undo functionality for bulk updates. It is recommended to run a Pre-flight and/or to
apply operations to a small set of objects before updating a large number of objects.

l Save configuration defines a location and name for the saved configuration so that it can be used again.
Click the ellipsis button ( ) to display the 'SaveOperation Configuration' dialog. To name a new

configuration, select a folder and type a name in the Name parameter, and clickCreate. To overwrite an
existing configuration, select the configuration and clickSelect.
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l Process Description displays the name for the background process.
l Available for object types limits the object types and nodes affected by the bulk update operations. First
select an object type from the dropdown, then click the ellipsis button ( ) to select the nodes to update.

2. ClickFinish to complete the bulk update configuration and start the operation(s) in a background process.
3. Monitor the bulk update as defined in theMonitoring Bulk Updates topic.
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Monitoring Bulk Updates
When a user completes the Bulk Update wizard, theBackground process status dialog displays. This allows a
user to monitor the status of the bulk update that was created.

ClickGo to Process to display the Background Process tab for additional information about the process
execution.

Note: If one operation on an object or the auto approval of the object fails, changesmade by other operations are
rolled back, and the object is left as it was prior to the bulk update.
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When the process has completed, the following options are available in theBulk Update Actions flipper on the
Background Process tab.

1. ClickSave to keep a copy of the execution report. This can be saved locally.
2. ClickTruncate if not all lines in the execution report are needed. Upon selecting Truncate, a dialog will appear

allowing users to select which lines to delete, and how many lines to retain.
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3. ClickRelaunch Wizard to open the Bulk Update wizard again. The wizard openswith the same objects
selected and with the same operations specified in the process that was just completed.

4. ClickBulk Update OK Objects if a pre-flight processwas run the bulk update should now be run on the
objects that were processed without errors.

5. ClickSave Failed Objects to save the objects for which the bulk update failed as a new collection. Note that
this option is only available if there were failed objects.

6. Click Impact Report to view a report of the errors that occurred during the bulk update process. This option is
only available if objects failed during the bulk update.
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Scheduling Bulk Updates for Collections
Scheduling a bulk update with collections is useful for a group of objects that needs to be updated on a regular
basis. The scheduled collection can save time instead of performing it manually. For example, if all current
accessory references should be removed before a group of objects is implemented into a workflow.

Prerequisites
The following tasksmust be completed before a collection is scheduled to run a bulk update.

1. Create a collection. More on creating a collection can be found in theCreating Collections topic in the
Getting Started / User Guide documentation.

2. Create a bulk update configuration. SeeCreating a Bulk Update topic for more on how to configure a bulk
update.

The steps below explain how to schedule a bulk update using collections.

Scheduling Bulk Updates
To perform a bulk update on a collection at regular intervals, create a schedule that applies to that particular
collection. The bulk update is then automatically run at the scheduled time.

Start the Bulk Update wizard

1. Open the Schedule Bulk Update wizard from File > Bulk Updates > Schedule Bulk Update.
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Setup

1. Click the ellipsis button ( ) to locate and select the relevant collection. This option is not valid if the collection is

created by going to File > Bulk Update > Run Bulk Update.

If the collection selected was created using the search criteria, and theRefresh before each run (Search
Collections only) checkbox is selected, it will refresh the collection based on the current data in STEP using
search criteria, before executing the bulk update operation(s).

2. Click the ellipsis button ( ) to locate and select the relevant configuration.

3. CheckAuto approve changes if you want to place the updated objects in the approved workspace
immediately after the update.

4. ClickNext.
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Preview

1. Review the example results of the update.

2. ClickNext.

Schedule Process
1. Create the time schedule by selecting eitherNow, Later,Weekly,Monthly, or Later and repeat.
2. Complete the options related to the schedule.

3. ClickNext.
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Name Process
1. Enter a name for theSchedule Process Name parameter.
2. TheProcess Name parameter displays the name displayed in the Background Processes tab.
3. ClickFinish to complete the wizard.
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Run the Background Process

1. On the Background Processes dialog choose an option:

l ClickGo to process to display the background process.
l ClickClose to display the workbench.

2. Viewing the process shows a bulk update that is scheduled to run at a later time under 'Queued processes.'

The Execution Report shows the processwith a Status of 'waiting.'
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